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Using this 
template 

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance 

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Auto-
updating of 
contents 
page 

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 
Inserting new 
headings 

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables 

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs 

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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Esholt 
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1.1  Introduction and background 

1.1.1 Background 

In May 2016, CH2M were commissioned by the Environment Agency, on behalf of Bradford 
Metropolitan District Council (BMDC), to undertake a package of initial assessments into flooding 
issues in the Yorkshire area. This report focuses on an initial assessment for Esholt village, in 
West Yorkshire, and provides guidance on measures to reduce flood risk and identifies potential 
funding availability. A site visit for this Initial Assessment was undertaken on 18th of July 2016 to 
the Church Lane area of Esholt. This report has been produced with information from the site visit 
and previous studies and reports that are relevant to this Initial Assessment. 

 

1.1.2 Description of Location 

Esholt is a small village, with approximately 90 properties, in the metropolitan district of the City of 
Bradford in West Yorkshire. It is located between Shipley and Guiseley. The River Aire is located 
approximately 300m south of the village, however Esholt itself is not located within the natural 
floodplain. Esholt is made up of three landscape types: enclosed pasture, wooded incline and 
floodplain pasture.  

According to the Index of Multiple Deprivation (IMD), Esholt is amongst the 50% least deprived 
areas in the country. There is currently a flood warning area within Esholt, however properties on 
Church Lane are not covered by this flood warning area. 

A location plan of Esholt which details the approximate locations of culverts can be referred to in 
Figure 1, Appendix D. 

1.1.3 Description of Watercourses and Geology 

Very limited information is available on the watercourses around Esholt. The River Aire is the 
largest watercourse in the study area and is located approximately 300m south of the village and 
is classified Main River.  The River Aire runs from Malham Tarn in the Yorkshire Dales National 
Park and on to Airmyn where it discharges into the River Ouse. 

Three unnamed smaller watercourses were identified at the time of the site visit.  These 
watercourses all discharge into the River Aire south of St Paul’s Church in Esholt within 100m of 
each other.  The EA understand that all three watercourses are culverted beneath Esholt village. 
The locations of the watercourses and culverted sections are shown in Appendix D. 

The underlying bedrock in Esholt is Millstone Grit, overlain by lover coal measures. Ground 
conditions generally consist of freely draining, slightly acidic, loamy soils. 

1.1.4 History of Flooding 

The most recent flood event to occur in Esholt was during December 2015. The EA received 
notifications from circa 27 properties with flood reports. Amongst the damage caused in 
December 2015 in Esholt, were 8 records of damage to cellars and ground floors and a loss of 
fencing and a  dry stone wall to approximately 15 acres of land. Fourteen flood reports in Esholt 
stated that their properties were inaccessible by road for two days.  

Church Lane and the majority of properties within the village are located in Flood Zone 1, see 
Figure 1. Anecdotal evidence, provided by the EA and BMDC, during the site visit for this initial 
assessment, suggests the flooding was most likely caused by surface water and drainage related 
issues. The EA reported that during the event, the River Aire overtopped its banks adjacent to the 
sports grounds on Esholt Lane. It was not clear if the Aire overtopped its banks further 
downstream to the south of Church Lane. LiDAR data, obtained through the EA’s geostore, 
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shows the ground slopes down from Esholt village towards the River Aire suggesting that any 
surcharge due to culvert blockages would result in surface water flowing towards the Aire. One 
report at Pullman Lane stated that rods had to be used to unblock the culvert (currently not 
conclusive which culvert at Pullman Lane was blocked). Large stones had to be removed and it 
was noted that a possible rebuild may be necessary. It is possible that the blocked culvert at 
Pullman Lane, may have caused manholes to surcharge resulting in overland flow towards the 
River Aire and also properties on Church Lane. 

 

 
Figure 1 – Flood Map for Planning (Rivers and Sea) 
© Environment Agency copyright and database rights 2016. © Ordnance Survey Crown copyright. All rights reserved. Environment Agency,  

There are areas of the village designated at high risk of surface water flooding on the EA Risk of 
Flooding from Surface Water mapping, see Figure 2.   The high risk classification means that the 
study area has a greater than 3.3% (1 in 30) chance of surface water flooding in any given year. 

 

Figure 2 – Risk of Flooding from Surface Water 
 

Chuch Lane 

Chuch Lane 
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1.1.5 Summary of modelling analysis 

In 2008 hydraulic and hydrological modelling of the Upper River Aire was completed by JBA to 
support the development of the Flood Risk Management Strategy. For this study the River Aire 
was modelled from High Hill Weir upstream of Gargrave to Fleet Weir downstream of Leeds.  

This 2008 study aimed to define flood risk within this area and identify potential flood risk 
management options. This informed the Flood Risk Management Strategy for the Upper Aire 
which proposed flood risk management options for the short, medium and long-term.   
 
The report investigated two locations within Esholt for potential flood storage sites, however 
during the screening process it was decided that the two sites would not be taken forward for 
further consideration due to the potential storage areas being too small. 
 
The report states that the overtopping threshold for some areas in Esholt (open land, farmland, 
sports grounds, Esholt Sewage Treatment Works, Esholt Hall grounds and other outbuildings) 
was found to be 0.1% (1in10 year event) Annual Exceedance Probability (AEP). It was decided 
that no new local defences would be considered, however it was mentioned that individual 
property level protection could be suitable as a local solution. 
 
There are no further recommendations for Esholt village in this report. 
 
1.1.6 Drivers, Constraints and Opportunities 

The study area is covered by the Aire Catchment Flood Management Plan (CFMP), and is 
covered by sub-area 3 - Worth and Aire. A link to the Aire CFMP can be found here: 
https://www.gov.uk/government/publications/river-aire-catchment-flood-management-plan. The 
designated policy for the area at risk is Policy Option 5: Areas of moderate to high flood risk 
where we can generally take further action to reduce flood risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Table 1.1 Drivers, Constraints and Opportunities within the site extent. 

Political 

Drivers  Exist?  Summary Description 

Catchment 

Flood 

Management 

Plan Yes Aire CFMP 2010 

Catchment 

Flood 

Management 

Policy Yes 

Policy 5 – Areas of moderate to high flood risk 

where we can generally take further action to 

reduce flood risk. 

Economic 

Drivers   Exist?  Summary Description 

Funding Time 

Constraints Yes 

Must be obtained within 6 year programme of 

capital investment 

Technological 

Drivers  Exist?  Summary Description 

Improved 

Public Safety Yes Via reduced flood risk 

Environmental 

Constraints  Exist?  Summary Description 

Sites of Special 

Scientific 

Interest (SSSI) Yes 

Yeadon Brickworks & Railway Cutting (SSSI) is 

located about 1.2 kilometres to the north east 

from Esholt 
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Ancient 

Woodland Yes 

There are two ancient woodlands near Esholt. 

Hollins Wood and High End are located less 

than 200 metres from Church Lane in Esholt. 

There is also an Ancient Replanted Woodland 

called Jerrison Wood – located directly behind 

Hollins Wood and High End. 

Tree 

Preservation 

Orders Yes 

There are some trees protected by TPO’s. If any 

work to trees is needed within the designation, 

written permission from the council prior to 

any works being undertaken  is required 

Listed 

Buildings Yes 

There are 31 listed buildings located within the 

site extent including one Grade II* and thirty 

Grade II assets. 

 

 

 

 

1.2 Problem and objectives 

1.2.1 Problem 
During the December 2015 flood event, several properties in Esholt flooded due to prolonged 
heavy rainfall. It was recorded that 27 properties were affected by flooding (26 residential 
properties and 1 non-residential property). In addition, fluvial flooding affected caravan park 
located near to the Sports Ground on Esholt Lane. 
 
The flooding in Esholt, in December 2015, was most likely as a result of surface water flooding.  
However, details of the existing drainage network are limited. A number of assets have been 
identified, including three culverts which drain into the River Aire to the south of Church Lane 
(see Appendix D).  Unfortunately, the purpose and condition of these assets is yet to be 
established and the cause of the flooding is unknown, however one of the culverts is known to 
have been partially blocked at the time of the flooding.    
 
Four possible flood mechanisms have been identified; 

• high water levels in the River Aire causing the existing system to back up,  
• the existing network having insufficient capacity, 
• failure of the existing drainage system, and 
• flooding directly from the River Aire on the area along Esholt Lane due to high water 

levels in the river. 
    
Based on the EA comments during the site visit, fluvial flooding from the River Aire overtopping 
the banks near Church Lane has been ruled out. 
 
Further works are recommended to be able to accurately determine the flood risk and to be able 
to recommend mitigation measures. 
 
1.2.2 Objectives 

As outlined in the project mandate, the primary objective is to find the most suitable solution to 
reduce the risk of flooding in Esholt. However, without sufficient information for the existing 
assets, it is not possible to fully understand the flood mechanism in Esholt, and to propose a 
suitable list of options to reduce the risk of flooding. 
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The purpose of this report is to identify future works required to be able to undertake the initial 
assessment and propose mitigation measures.  

 

1.3 Benefits 

During the December 2015 flood event, 27 properties affected flooding (26 residential and 1 non-
residential). However, the benefits cannot be accurately assessed without identifying the flood 
mechanism and current standards of protection.  

 

1.4 Initial environmental assessment 

Expected works should not significantly worsen the environmental impact on the surrounding 
area. An environmental checklist has been completed for Esholt, highlighting environmental 
constraints in the area (Appendix C). Key environmental impacts should be reviewed should this 
project be progressed in the future.  
 
Table 1.2 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

• Reduces risk of and 
subsequent flooding 
 

• Reduces future 
maintenance costs  

• Construction work takes 
place near/ alongside 
watercourse. Measures 
to prevent pollution of 
watercourse will be 
required. 

 
• Loss of agricultural land 

due to creation flood 
storage area 
 

• There is likely to be 
increased noise/vibration 
levels during any works. 

• Best practice should be 
followed including referring 
to EA Pollution Prevention 
Guidance. 

• Early engagement with 
landowners recommended 
to enhance opportunities 
and minimum negative 
impacts 

• Local authorities and 
communities need to be 
fully engaged in 
maintenance activities 

• It is recommended that 
adverse impacts should be 
minimised as much as 
possible through the 
adoption of ‘best 
practicable means’ as 
defined in the Control of 
Pollution Act 1974 to 
minimise noise and 
vibration resulting from 
construction operations and 
shall have regard to British 
Standard BS 5228 1997 
code of Practice for Noise 
Control on Construction 
and Open Sites. 

 

1.5 Further work requirements 

If the project is to be progressed, it is recommended the following work is carried out in order to 
propose a suitable list of options to reduce the risk of flooding to properties in Esholt: 
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• Provide data for existing assets in Esholt by carrying out CCTV surveys and condition 
surveys of culverts to understand the culvert system and their current conditions. This 
information is required to understand if there are any issues with blockages or pinch 
points in the culvert system and also to understand what their capacity is. 

• There is currently very little hydraulic information available on the watercourses flowing 
through Esholt.  Detailed modelling of the three tributaries and culverts around Church 
Lane is required.  It is anticipated that a 1D hydraulic model will be suitable for the next 
stage of the assessment.  In order to build the model a full topographical survey of the 
watercourses is required including regular cross-sections and bank top levels. 

• The Leeds FAS Phase 2 scheme has identified three locations that could be potentially 
used as flood storage areas; Keighley Holden Park, Marley Bridge and Rodley.  The 
Rodley site is downstream of the Esholt study area but the other two sites could 
potentially provide benefits for Esholt.  The Upper Aire FRMS has estimated a reduction 
of 300mm to 400mm for a 1% (1 in 100 year) AEP event at Leeds Station.  The impact at 
Esholt, however, is uncertain but is expected to be significant on peak water levels.  Any 
future investigation should consider the impacts of the upstream storage areas on Esholt. 

 

1.6 Conclusions and Recommendation 

Before this initial assessment can be progressed, it is recommended that the following minimum 
investigations are carried out to better understand the problem at this site: 

• Carry out CCTV surveys and condition surveys to understand the culvert system in 
Esholt.  

• The ownership and inlet levels of the outfalls needs to be ascertained as a part of future 
work 

• Modelling of the River Aire, tributaries and culvert system in Esholt to fully understand the 
flood mechanism and to assist with proposing solutions. 

 
In addition, if the findings of the Leeds FAS Phase 2 modelling study are available, they should 
be taken into account for any further assessments for Esholt. 


